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When Steve JobS introduced the iPad on January 27, 2010, the world 

expected another game-changing product from Apple. But few of us in 

publishing and design realized how profoundly it would change our world. 

Today, an increasing number of books and magazines are read with a swipe 

and a touch onscreen. Buttons and video are becoming as commonplace 

as editorials and classifieds. And the experience of reading is becoming 

much more immersive and engaging in the process.

InDesign is at the center of the publishing world for print, so it’s not 

surprising that it has now become a key part of publishing to the iPad and 

other tablets. With InDesign and Adobe’s complementary set of tools, 

known as the Digital Publishing Suite, a whole new world of design and 

interactivity has opened up to designers and publishers everywhere.

Understanding Digital Publishing Suite Apps
Several third-party products allow you to convert your InDesign layouts 
to tablet apps for the iPad, Kindle Fire, or Android tablets. Most of them 
provide a set of free plugins for creating interactive overlay elements, 
along with some means of converting your documents into an app. Our 
focus in this chapter will be on Adobe’s solution: the Digital Publishing 
Suite, also known as DPS.

Adobe’s Digital Publishing Suite consists of several components that 
allow you to bring your InDesign layouts to life as applications on tablets 
that include the iPad, the Kindle Fire, Android tablets such as the Samsung 
Galaxy, and even the iPhone (though our focus throughout this chapter 
will be on tablet apps). The DPS tools allow you to add interactive features 
to your publication and to publish your file in a folio format that allows 
it to be shared and published to tablet devices.

DPS tools include several components. Each plays a different part in the 
process of creating a tablet app from your InDesign layout.

■■ Folio Overlays panel: An InDesign panel that allows you to add 
interactive features for tablets to your layout.

■■ Folio Builder panel: An InDesign panel that allows you to assemble 
your files into folios, which are files that can be previewed and shared.

■■ Adobe Content Viewer (desktop version): A computer application 
that allows you to preview your content and interactivity as it will 
appear on a tablet.

DPS tools
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■■ Adobe Content Viewer (device version): A free application that is 
installed on your iPad (or other tablet) and allows you to preview 
your content and interactivity.

■■ Folio Producer: A browser-based application for organizing your 
folio files, adding metadata, and publishing folios.

■■ Viewer Builder: An Adobe AIR application that allows you to build 
a custom viewer app for your content that you can submit to Apple’s 
App Store, Amazon’s Appstore for Android, or Google Play.

The Folio Builder panel is part of the standard installation of InDesign 
CS6. When you first open the panel, you will be prompted to update the 
panel by clicking a link. This takes you to Adobe’s website, where you can 
download the latest version of the DPS tools. Installing this package will 
add the Folio Overlays panel to InDesign and install the Desktop Viewer 
on your computer’s hard drive. As the DPS tools are updated, the Folio 
Builder panel will prompt you to download the latest version.

To finally publish your app and make it available for sale requires that 
you sign up for one of three DPS subscription programs. At the highest 
and most expensive level are the Enterprise and Professional Editions, 
which are geared to mid-sized or large publishers. These allow publica-
tion of an unlimited number of single-issue folios or subscription-based, 
multi-issue folios (such as monthly magazines) on the iOS and Android 
platforms. Both also provide analytics, or data, about the folio downloads, 
with the Enterprise Edition offering additional services, such as the ability 
to create in-app custom navigation. 

The Single Edition, which allows you to publish single-issue folios only, 
offers a more affordable entry point for small and individual publishers. 
In fact, the Single Edition will be made available to all Adobe Creative 
Cloud members for free. Non-subscribers to Creative Cloud have to pay a 
one-time license fee, which at the time of this writing is $395. The Single 
Edition is currently available for iPad only.

No matter which version you use, the tools and the creation process 
are the same. And anyone with an Adobe ID can use these tools to create 
and share folios with others. 

One important thing to note is that the components of DPS are regu-
larly updated, so you’ll want to check out the resources mentioned at the 
end of this chapter.
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The basic DPS workflow involves multiple steps. The diagram below 
illustrates the overall process. 

Sell

Analytics

Preview

Share

Publish Create  
App

Creation Production Distribution

The basic DPS workflow includes adding interactivity to your layouts, using the Folio Builder 
panel to assemble them into a folio to preview and share, publishing the folio, and creating an 
app for sale in the appropriate marketplace.

The first step is to design your publication for viewing on a tablet and 
to add interactivity where appropriate. Design issues are discussed in the 
next section, “Design and Workflow Considerations” on page 125. Inter-
activity is added using InDesign’s built-in features (covered in Chapter 2) 
and the Folio Overlays panel, discussed in the section “Interactivity and 
Digital Overlays,” on page 130. 

Next, your individual InDesign documents, called articles, are assembled 
into a folio, which you can think of as the file format for a tablet app. 
This assembly is done using the Folio Builder panel in InDesign, which 
is discussed in the section “The Folio Builder Panel” on page 157. You can 
also import HTML articles into your folio, but we’re going to focus on 
working with InDesign files.

Once you’ve created your folio, you can preview it in a number of ways. 
You can view it on your computer by clicking the Preview button in the 
Folio Builder panel, which opens the Desktop Viewer. Or, install the Adobe 
Content Viewer on your iPad or other tablet, then sign in with your Adobe 
ID. The folio will then be available on your tablet. Both of these options 
are discussed further in “Previewing folios and articles” on page 167.

DPS workflow overview
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If you need to share your folio with others on your team or with a client, 
you can do so by clicking the name of the folio in the Folio Builder flyout 
menu and choosing Share from the menu. You can then enter multiple 
email addresses inviting others to view the folio. In order to view the folio, 
invitees must have an Adobe ID to sign in, and they can view the folio 
either on their tablet (using the Adobe Viewer) or in their Folio Builder 
panel in InDesign. See “Sharing folios” on page 170 for more information.

Once your folio is complete, use the Folio Producer to publish it to 
Adobe’s distribution system, the first step to getting your app in the Apple 
App Store, Amazon’s Appstore for Android, or Google Play. 

Whether you create a folio to share with a few colleagues or publish your 
app for sale to the general public, all DPS apps allow you to navigate pages 
in the same way, and all share a common user interface, or chrome — con-
trols that appear when the user taps the screen. The only exceptions are 
Enterprise Edition apps created with a custom interface. But the vast 
majority of DPS apps share the same “look and feel.”

When you download the free Adobe Content Viewer for your tablet, 
you’ll find an illustrated help file that explains this basic navigation and 
interface. It’s also common when publishing an app to include a similar 
help file so that users unfamiliar with the interface can fully experience 
and engage with your app.

Most DPS apps are set so that you read an article by swiping verti-
cally. The article may be set as individual pages or as one long, scrolling 
article. Swiping horizontally moves to the next article. However, a folio 
can also be set so that the user swipes horizontally only, much the way a 
print publication is read. With this navigation, the user basically swipes 
through every page of the publication. 

When the user taps the screen, standard DPS navigation controls 
appear. These controls include the following icons:

■■ Home: tap to return to the app library.
■■ Table of Contents: tap to display the table of contents.
■■ Previous View: tap to go back to the previously viewed page.
■■ Browse Mode: tap to display thumbnail images of the articles.
■■ Scrubber: drag to scroll through the article thumbnails.

DPS app navigation 
and user interface
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Home icon Table of Contents icon Previous View icon

Browse Mode icon Scrubber

DPS apps have a standard interface for navigation, also known as the chrome. The user taps the screen once to display the chrome 
and can then navigate the app’s pages.

Design and Workflow Considerations
Although tablet apps are electronic, they still use the concept of “pages.” 
But the design issues involved can be quite different from those encoun-
tered when designing for print. Interactive elements require a different 
way of thinking about how information is presented, and even about how 
the user is informed that elements of the page are interactive.

Another important difference is that many print publications, especially 
books and magazines, are really designed as facing-page spreads. Because 
the reader experiences both pages at once, they are effectively viewed as 
though they were a single page. When content moves to a tablet, there 
is no notion of spreads, and the overall design and design elements need 
to hold up in what are essentially single-page layouts.
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One of the first decisions you need to make when converting a print pub-
lication to a tablet app is the orientation of the pages in the app. Because 
the iPad and most other tablets have a built in accelerometer, the screen 
rotates depending on how you hold the device. You can design your pub-
lication with pages that can be viewed in only a vertical orientation, only 
a horizontal orientation, or both vertical and horizontal orientations.

Some publications use only a single orientation. Martha Stewart Living (left) is vertical only, and National Geographic (second 
from left) is horizontal only. Others, like Wired (right and second from right), use both vertical and horizontal orientations.

There is no right or wrong decision regarding page orientation. One 
thing to keep in mind, though, is that creating a publication with both 
orientations is going to be more work than creating a single-orientation 
app. New features in CS6, such as Liquid Layout rules and alternate layouts 
(discussed in Chapter 4), help with the process, but building an app with 
both orientations still requires extra effort.

Although tablet apps don’t display pages in spreads like print publications 
do, the content still needs to hold up on its own page. One nice thing 
about pages on tablet apps is that they can be set as individual pages 
(similar to a print publication) or as scrolling pages (so that content is 
one continuous page that scrolls vertically).

The most common types of articles or pages that are set as scrolling 
pages are tables of contents, letters from the editor, credits, and colo-
phons — “list type” articles. Other types of stories that are well suited to 
scrolling pages are articles that consist of short snippets of information, 
such as new product releases, new hot spots to visit, or anything that is 
essentially a list of items. On the other hand, long blocks of text such as 
feature stories can be harder to read in a scrolling view. It's usually best 
to set those types of articles in a page-by-page view. 

Scrolling pages are easy to set up in InDesign. Simply make the InDe-
sign page long enough to fit the article. For example, you might set a 
horizontal page to 1024 x 2000 pixels and a vertical page to 768 x 2000 
pixels. (The maximum page size in InDesign is 15,562 pixels.) You can also 

Page orientation: 
H, V, or both?

Scrolling vs. 
individual pages
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set the article to Smooth Scrolling in the Article Properties dialog box, 
discussed later in this chapter.

Whether content is set up in individual pages or as one scrolling page, 
it's a good idea to give the reader some visual cue that more content is 
available. This cue could be a graphic image that you can see only part of, or 
it could be an arrow or other icon that points toward the rest of the article. 

Fonts look beautiful on tablets, especially on the Retina display iPad 
(2012), but that doesn’t mean you don’t have to make adjustments for 
tablet apps. When it comes to fonts, the main difference between layouts 
in print and on tablets is that very often body text that looks fine in print 
is too small on the tablet version. Most publications increase the body 
text size by at least 1 point or more, along with increasing any smaller 
text in the layout.

When you’re working with images for tablet apps, there are a couple of 
things to keep in mind. Like fonts, images look fantastic on most tablets. 
But keep in mind that tablets use an RGB color space, so it’s a good idea 
to keep your images in RGB whenever possible. You can download an ICC 
profile for the iPad at http://indesignsecrets.com/downloads/forcedl/
iPad.icc. Load this profile into all your Creative Suite applications, and 
you’ll get more accurate color matching results. 

You’ll also want to keep your options open when cropping an image. 
Avoid destructive cropping. For example, you may crop an image one 
way for the cover of your vertically oriented print publication, but if you 
are creating a horizontal orientation for your tablet app, you’ll need to 
crop the image differently, with more of the image showing on the sides.

Use high-resolution images for all non-interactive content. InDesign 
will automatically sample the images correctly for the device you’re 
designing for. Some interactive content is sampled and some is not, as 
we’ll discuss in later sections.

Part of what makes publications on tablets so compelling are the interactive 
features that can be included. There’s nothing like buttons, slideshows, 
or movies to spice things up! Because interactivity is such an important 
part of the tablet app experience, it’s important that your readers know 
it’s there. 

The most common way to guide users to interactive elements is to 
develop a series of icons that indicate different types of activity. These 
can be included on a help page at the beginning of your publication to let 
users know how to navigate and use the DPS controls that appear when 
the screen is tapped.

Fonts and images

Interactivity visual cues

http://indesignsecrets.com/downloads/forcedl/iPad.icc
http://indesignsecrets.com/downloads/forcedl/iPad.icc
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Indicate interactive elements in your app by developing a system of icons. These are the icons 
used in National Geographic (top) and Martha Stewart Living (bottom). 

There are many issues regarding workflow when creating a tablet app 
publication, especially when it’s in conjunction with a print version. We 
can’t cover them all in detail here, but we’d like to mention a couple of 
very important things to consider.

First and foremost is the issue of resources. Whether you work on your 
own or are part of a workgroup, it takes time and energy to create a tablet 
app of your publication. Even with the tools that were added to CS6 to 
make the process of creating documents in multiple sizes and orientations 
easier, don’t underestimate the additional work that’s going to be involved. 
As we’ve been highlighting in this section, the design considerations for 
tablet apps are quite different from those for print. 

Another part of the typical workflow that is affected is proofing. How 
do you proof interactive content? How do you mark it up for changes? 
Certain elements can be output from InDesign in PDF format, but many 
cannot, or not very easily. Imagine you have a slideshow created with 
object states, each of which includes an image and text. You could make 
a PDF, but you’d have to make one for each state, one by one, and this 
can be very time consuming.

TIP The most important step you can take in planning your workflow for creat-
ing a tablet app is this: Plan ahead!

If you know you will be creating both a print and a tablet app version of 
your publication, plan for both at the very beginning. Allocate resources, 
whether it’s your own time or that of others, and right from the start, 
think about the assets as they relate to both your print version and your 
digital version.

Workflow 
considerations
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Setting Up Your Document
Part of the creation process for a tablet app is to set up your file properly. 
If you’re creating a document, InDesign CS6 has a new intent in the New 
Document dialog box: Digital Publishing. 

The Digital Publishing intent changes several default settings in the New Document dialog 
box, and it sets the Swatches panel to RGB when the document is created.

The Digital Publishing intent sets a primary text frame, which allows 
your text to reflow when you create alternate layouts. It also sets the 
Pages panel to display alternate layouts. Dimensions are set to pixels, 
pre-set page sizes for a number of popular mobile devices are listed, 
and the Swatches panel is set to RGB colors. Any of these settings can 
be changed, of course, and they can be captured for future use with the 
Save Preset option.

Keep in mind that many devices have an area that is used for naviga-
tion. For example, the iPad has a 6-pixel wide area on the right side of the 
screen that displays a scroll bar and crops the layout. You can download 
templates for the iPad that have guides to indicate parts of the screen that 
will be covered by the scroll bar or other parts of the interface at http://
gilbertconsulting.com/resources-misc.html. 

http://gilbertconsulting.com/resources-misc.html
http://gilbertconsulting.com/resources-misc.html
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Pre-set page sizes in the New Document dialog box include several popular mobile devices.

Interactivity and Digital Overlays
Many of the interactive features for tablet apps are added to your InDe-
sign documents using the Folio Overlays panel. These elements are called 
overlays because when you create a folio, all the non-interactive elements 
in your layout are flattened to a JPEG, PNG, or PDF file, depending on the 
settings you use; the interactive elements sit on top of that, as an overlay.

Interactive elements are in an overlay that sits on top of the non-interactive elements in your 
layout.

One of the nice things about overlays is that they are maintained 
in both a horizontal and a vertical orientation, with no special action 
required on your part. As long as the same name is used for objects in 
each layout, the overlay will be consistent. For example, that means that 
if you are viewing the second slide in a slideshow in one orientation, the 
same slide is displayed when the user rotates the tablet.

Some of the interactivity that you can add to DPS apps is created using 
InDesign’s native interactive features (discussed in Chapter 2), which can be 
used in PDFs as well as DPS apps. But most of these elements require some 
additional settings in the Folio Overlays panel, because of characteristics 
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that are unique to tablets. For example, when you have a hyperlink to a 
website, you need to indicate whether the page will open directly within 
the tablet app or in the tablet’s browser app. 

Other interactive elements are unique to tablet apps, and these ele-
ments are added using the Folio Overlays panel. We’ll discuss each of 
these in detail later in this section. 

Most, but not all, of InDesign’s native interactive features are supported 
by DPS. The following table shows which native InDesign interactive 
features are supported and which are not.

Feature Supported by DPS Not Supported by DPS

Animations Not supported directly; animations must be converted to HTML5 and 
placed back in the InDesign file

Hyperlinks URL, email, Page, and Navto only Text anchors and Shared 
Destination hyperlinks

Buttons On Release event only; Go To First/
Last page, Go To URL, Go To Page, 
Go To Previous/Next State, and Go 
To State actions only

On Click and On Rollover events; 
Go To Destination, Go To Next/
Previous Page, and Show/Hide 
Button actions

Forms Not supported

Audio MP3 files 

Video MP4 files with h.264 encoding

Bookmarks Not supported

Cross-References Not supported

Page Transitions Not supported

The Folio Overlays panel extends the native features it supports by 
allowing you to add elements that are unique to tablet apps. But the 
panel also adds overlays that provide additional interactive features to 
DPS apps, including the following:

■■ Image sequencing
■■ Panoramas
■■ Web views
■■ Pan and zoom on images
■■ Scrollable frames

These features are created entirely using the Folio Overlays panel and, 
usually, a set of external files.

The Folio Overlays panel is essential to adding much of the interactivity 
to DPS apps. After you install the DPS tools from the Folio Builder panel, 
you can find the Folio Overlays panel under the Window menu.

Native interactive 
features supported

Folio Overlays 
panel basics
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The Folio Overlays panel lets you access all of the interactive features you can modify or create 
for DPS apps.

Think of the Folio Overlays panel as your hub for adding interactivity to 
your DPS apps. It provides important tools for creating engaging experi-
ences for your publication’s readers, and previewing your work as you go 
along, either using the desktop Content Viewer or directly on your iPad.

Both buttons and hyperlinks play an important role in providing interac-
tivity to DPS tablet apps. They provide navigation, allow us to play videos 
and sounds, click through slideshows, and link us to the outside world.

When to use buttons vs. hyperlinks
Because both buttons and hyperlinks have similar linking functionality, 
it can sometimes be confusing to know when to use a button rather than 
a hyperlink. But they each have unique characteristics that when under-
stood make it easy to choose the right feature for the job.

For one thing, only entire objects or frames can be made into a button; 
you can’t select text within a frame and set a button, you can only set a 
hyperlink. That makes hyperlinks the only choice when you need to link 
selected text within a frame.

Creating links with 
buttons and hyperlinks
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On the other hand, buttons are the only choice when you want the 
appearance of your link to change when it’s tapped. Buttons have appear-
ance options for Normal, Rollover, and Click, but only Normal and Click 
appearances are utilized by DPS. Only buttons let you jump to an object 
state, which is useful for slideshows, remote rollovers, or button “hot 
spots.” 

You can use either buttons or hyperlinks for similar kinds of links: 
■■ To link to websites
■■ To link to other pages or articles
■■ To send email
■■ To link to other content 

Creating buttons for DPS apps
Creating a button for a DPS folio is the same as creating a button in 
InDesign for any other type of use, such as for a PDF file. However, there 
are certain events and actions that do not work in DPS apps and cannot 
be used. In fact, the only button event that is supported by DPS is On 
Release or Tap.

The only button event supported in DPS is On Release or Tap. The others have no effect when 
exported to a DPS folio.

There are also certain button actions that are not supported in DPS 
folios, including Go To Destination, Go To Next/Previous Page, and Show/
Hide Buttons And Forms. None of the PDF Only actions are supported.

DPS supports the following button actions for hyperlinks:
■■ Go To First/Last Page
■■ Go To Page
■■ Go To URL
■■ Sound
■■ Video

DPS supports the following button actions for object states:
■■ Go To Next/Previous State
■■ Go To State 
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These actions are supported by DPS with no additional settings 
required. But whether you use buttons or hyperlinks, you must use the 
Folio Overlays panel to set how URL hyperlinks behave.

Use the Hyperlink settings to specify whether a link opens in the app (folio) or in a browser.

Panel settings
Open in Folio: By default, a website will open in the app, in an in-app browser, 
where all links on the website are fully functional. With this option, the 
user never leaves the app. To return to the app, the user simply taps the 
Done button in the upper-left corner of the screen.
Open in Device Browser: Choose this option if you want the user to be 
taken to the device’s browser app, such as Safari on the iPad, when a link 
is tapped. With this option selected, the user will exit the app and go to the 
external browser. Always choose this option for email links, because you 
always want the user’s email client to open to send a pre-addressed email. 

TIP When setting a link to iTunes or the Apple App Store, use the Open in 
Device Browser option to avoid a Cannot Open Page error message.

Select the Ask First check box to specify that a prompt will appear, 
requesting permission to exit the app. It’s usually a good idea to specify 
this prompt, so the user knows what’s about to happen. Once the user 
is in the browser app, the DPS app has been completely exited and the 
app has to be re-opened.

Jump to another article 
To create a hyperlink to jump to another article in your folio, use the 
navto:// syntax. Then specify the name of the article as it appears in the 
Folio Builder panel, not as it appears in the Article Properties dialog box. 
(Both are discussed in detail later in this chapter.) Add a page number if 
you wish to link to a specific page in the article. When you’re linking to 
a specific page in an article, keep in mind that the first page in the docu-
ment is counted as page 0 (zero). So, for example, if you specify #3 in the 
URL, the link will jump to page 4. A typical URL to link to another article 
in your folio might be something like navto://articlename#3.
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Slideshows are just one of the many interactive elements that can be 
made using object states. In DPS apps, slideshows can be navigated by 
using buttons or by using tablet actions (such as Tap or Swipe) that are 
specified in the Slideshow section of the Folio Overlays panel.

As discussed in Chapter 2, you make an object state, also known as a 
multi-state object or MSO, by combining multiple objects into one. Select 
the objects — whether several images or a series of images grouped with 
text — and align them on top of each other using the alignment icons 
in the Control panel. Then in the Object States panel, click New, which 
groups the objects into a new object state.

 

Creating an object state: Select a group of images and align them; click the Convert Selection 
to Multi-state Object icon in the Object States panel.

To allow the user to view the slideshow by tapping buttons that access 
a specific state or by browsing slide by slide, set the buttons to the Next/
Previous State action. Or, you can allow the user to view a slideshow 
without any buttons by selecting the appropriate settings in the Slideshow 
section of the Folio Overlays panel.

Panel settings
Auto Play: As soon as the user turns to the page, the slideshow will play; 
this is also known as “play on page load.” If you select this setting, you 
can set a delay in the time it takes to play.
Tap to Play/Pause: The slideshow will play when the user taps the top image 
or state. If you select this option, it’s a good idea to give some kind of 
visual cue, such as an icon or text, that clearly indicates that the slideshow 
should be tapped to see the action, since the user otherwise just sees the 
static image of the first slide.

Creating slideshows 
with object states
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Use the Slideshow section of the Folio Overlays panel to specify settings for your slideshow.

Delay: If Auto Play is selected, you can specify a delay in the time between 
when the user turns the page and when the slideshow starts to play. You 
can specify from 0 (zero) seconds to 60 seconds. It’s usually a good idea 
to set a small delay so the page elements have time to fully load before 
the slideshow starts to play.
Interval: If Auto Play or Tap to Play/Pause is selected, you can specify the 
amount of time each slide displays. The allowable range is 0.125 seconds 
to 60 seconds.
Play-Time: If Auto Play or Tap to Play/Pause is selected, you can specify 
how many times the slideshow plays. This option is not available when 
Loop is selected.
Loop: If Auto Play or Tap to Play/Pause is selected, selecting Loop will 
cause the slideshow to play continuously until the user double-taps the 
slideshow or turns the page. Many electronic document designers decry 
Loop as a distraction.
Stop at Last Image: If Auto Play or Tap to Play/Pause is selected, this setting 
will stop the slideshow at the last slide.
Cross Fade: This setting provides a transition fade to the next slide. The 
default time for the transition is .5 seconds, but you can specify any value 
from 0.125 seconds to 60 seconds. This applies to slideshows advanced 
manually or with Auto Play or Tap to Play/Pause selected.
Swipe to Change Image: This setting lets the user swipe from slide to slide.
Stop at First/Last Image: When Swipe to Change Image is selected, use this 
setting to specify that the slideshow stop on the first or last slide. 
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Hide Before Playing: If this setting is selected, the slideshow is hidden 
until it is triggered, either by user action or by other settings in the Folio 
Overlays panel.
Play in Reverse: Just like it sounds, selecting this option causes the slide-
show to play backwards.

Object states are used frequently in DPS apps because you can do so many 
different things with them. One common use of objects states is to create 
what is sometimes referred to as a “remote rollover.”

Remote rollover usually refers to an effect where the user rolls over one 
part of a page onscreen and a change occurs in a remote (unconnected) 
part of the page. On tablets, there is no rollover state, so in this case it 
refers to when the user taps one part of the screen and a change occurs 
in another part of the screen. Remote rollovers can be created using an 
object state and buttons that go to specific states in the object state.

In this example, the user taps any one of four buttons to display a 
different yoga pose, along with how-to instructions. 

In this remote rollover, the user taps one of the numbered buttons to display a different yoga 
pose with instructions.

1. The first step is to create each object state. A yoga pose image is 
positioned next to the text frame containing its instructions, and 
then the two are grouped. 

2. Once all four images are grouped with their instructions, the four 
groups are then aligned on top of each other and converted to an 
object state using the Object States panel. 

3. Next, the four buttons are created. Each button has a different 
image for the Normal and Click appearances. See Chapter 2 for 
information about using external graphics for button appearances.

4. For each button, the event is set to On Release or Tap and the action 
is set to Go To <the appropriate> State.

Creating remote 
rollovers with 
object states



138

Digital Publishing with aDobe inDesign Cs6

Each state is made up of an image grouped with instructional text in an adjacent text frame.

Each button is targeted to a specific state in the object state to create the remote rollover 
effect.

This technique offers a lot of flexibility, and with a little imagination 
and creativity you can produce a variety of engaging experiences for your 
users. You’ll see this technique used in many of today’s tablet publications.

Image sequencing allows you to combine many images into a continuous 
series that can be stepped through by the user. It is particularly useful for 
creating a rotating 360° view of images or a time-lapse series of images. 

Image sequencing
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Image sequencing is one of the interactive features that are unique to 
DPS, and it uses the Folio Overlays panel rather than the File > Place 
command to import the images used. 

There are a variety of ways to create source images. One way is to use 
Adobe Photoshop Extended to export an image sequence of a video, 
whether a 3D object or a scene. Open the movie in Photoshop Extended, 
and use the File > Export command. Choose Render Video and change 
the settings in the dialog box as needed.

The Render Video dialog box in Photoshop. You can create the assets needed for an image 
sequence by opening a movie file in Photoshop Extended and exporting the frames as an 
image sequence. 

You can also use Adobe Flash Professional or Adobe After Effects to 
export frames from an animation or a video. And, of course, you can use 
any 3D authoring application to generate images.

Images should be saved in JPEG format, or PNG if you wish to include 
transparency. InDesign won’t compress the files in any way, so for JPEG 
files, use medium compression to keep your folio size down. 

The files should be named with sequential ascending suffixes, such 
as image01.jpg, image02.jpg, image03.jpg, and so on. You also need to 
make the images the same pixel size as they will appear on the tablet; for 
example, 568 x 320 pixels.

TIP Use at least 30 to 60 images so their rotation will not be jerky. You usually 
don’t need more than that, and using too many images will just make your file 
larger without a better result.
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Combine all your images in a folder that will be just for these assets. 
You’ll point to this folder to create the overlay.

monkey040.jpgmonkey020.jpgmonkey000.jpg

Image sequence files must be named with sequential ascending suffixes. Shown are three files 
from different points in a sequence.

The next step is to create a container frame in your InDesign layout 
and decide on the poster image you want to display. This will be the image 
the user sees when turning to the page. You can set the first image in the 
sequence as the poster, or you can use File > Place to insert an image that’s 
not in the sequence as the poster.

If you want the first image in the sequence to be the poster, you can 
draw a frame of any size, because when you load the images the frame 
will automatically be re-sized to fit the content. If you want some other 
image to be the poster, place an image into a frame that is the exact size 
of the images in your sequence.

To import the images, select the container frame, and in the Image 
Sequence section of the Folio Overlays panel, click the Load Images folder 
icon at the top. Locate the folder containing the image assets. 

Use the Image Sequence controls to load your images and to specify settings such as Auto Play 
and Swipe to Change Image.
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Panel settings
Show First Image Initially: This setting will use the first image in the sequence 
as the poster and will re-size the selected frame to fit the image. 
Auto Play: This will cause the image sequence to begin playing on page load.
Tap to Play/Pause: This setting will allow the user to tap the image sequence 
to begin playing; a second tap will pause it.
Delay: If you set the image sequence to Auto Play, this setting lets you 
set a delay before it starts playing. It’s a good idea to set a short delay to 
give the page time to fully load before the image sequence starts to play.
Speed: This allows you to set the number of frames per second at which 
the sequence will play. It should not exceed the frame rate at which your 
images were sequenced.
Play: This setting lets you specify how many times you want the sequence 
to play.
Loop: This setting causes the sequence to loop, or play continuously, until 
stopped by a user action, such as a tap or a page turn.
Stop at Last Image: If Auto Play or Tap to Play/Pause is selected, this setting 
will stop the slideshow at the last slide.
Swipe to Change Image: This setting allows the user to swipe the image and 
move the images as slowly or quickly as desired, essentially allowing the 
user to step through the sequence.
Stop at First and Last Image: When Swipe to Change Image is selected, 
selecting this setting will stop the sequence at the first image and the last 
image. If this setting is deselected, the user can spin the image sequence 
continuously.
Play in Reverse: This setting will play the image sequence in reverse. 

You can include both audio and video files in DPS apps. Some of the 
properties for audio and video are set in the Media panel, as discussed 
in Chapter 2, and others are set in the Folio Overlays panel.

In order to include audio files in your DPS app, use the File > Place 
command to position an audio file in your InDesign layout. For DPS apps, 
the audio file must be in the MP3 format.

Next, you may optionally use the Media panel. You can use the Media 
panel to set the file to Play on Page Load, which automatically turns 
on the audio Auto Play option in the Audio & Video section of the Folio 
Overlays panel. You can also use the Media panel to set a simple poster 
for your video, but if you want a controller image for play and pause, for 
example, use the Folio Overlays panel, as discussed in the next section. 
Frankly, unless you want to set a single image for a poster, there is no 
particular reason to use the Media panel.

Working with 
audio overlays
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Some settings for audio can be controlled from the Media panel.

Next, you can set the audio file to play when the user turns to the 
page, or you can create buttons that the user can tap to play, pause, or 
stop the video. These options are discussed in more detail in Chapter 
2. Alternatively, you can use controller files instead of buttons to allow 
the user to play or pause the sound file, as discussed in the next section.

Working with controller files
One of the interesting things you can do with the Folio Overlays panel 
is to set images to control the audio playback. You can create either a 
simple controller or a progressive controller, which shows the progress 
of the audio as it plays.

For a simple controller, you need only two files. However, they must 
have very specific names. Name the files with a _pause or _play suffix, 
such as audio_play.png and audio_pause.png. Add these two images to an 
assets folder that contains no other files.

Use the Folio Overlays panel to load a series of images that will display as a progressive con-
troller bar, showing the progress of the audio as it plays.
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Next, load the images by clicking the Controller Files folder icon in the 
Folio Overlays panel. Point to a folder that contains only the controller 
images. To use the audio_play.png image as the poster image, select the 
Show First Image Initially check box.

For a progressive controller, the images must be named in a very specific 
sequence that includes an increasing number, such as audio01_play.png, 
audio01_pause.png, followed by audio02_play.png, audio02_pause.png. As 
the audio plays, the images will be shown in a sequence that displays a 
visual of the audio progress. The total number of play files you use will be 
divided equally by the length of the audio. For example, if your audio is 
30 seconds and you want the image bar to progress every second, create 
a total of 30 files, named audio_play01.png to audio_play30.png, with their 
corollary pause versions.

audio01_play.png

audio01_pause.png audio03_pause.png audio11_pause.png audio20_pause.png

audio03_play.png audio11_play.png audio20_play.png

These images are part of a sequence that displays the progress of the audio as a controller that 
fills up from bottom to top as the audio plays.

It’s also a good idea to create the images in the exact pixel size they’ll 
appear in; scaling them up will cause pixelation, and scaling them down 
will make the file size larger than it needs to be. Use PNG or JPEG images 
with medium compression to best balance image quality and file size.

Because it can take quite a bit of time to create the images for a progres-
sive controller (unless you automate the process; see the sidebar on the 
next page), it’s a good idea to decide on a controller look that you want 
to use throughout your app publications. It can be very time consuming 
to change them all with each new issue.
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Using Illustrator to create audio controllers
Adobe Illustrator is the perfect application for creating the image sequence for an 
audio file controller. You can create objects for Start and Pause buttons and then use 
blends to precisely create the progress display. For example, if the audio takes five sec-
onds to play, you create a blend with nine steps, including the start and end objects. 
This creates a player that runs for five seconds, with each step lasting half a second.
Once you’ve created the artwork, exporting PNG files from Illustrator is tedious. And 
if you need to make a small change, it’s twice as tedious.
Adi Ravid has created for Illustrator a simple script, DPS Audio Player SkinMaker, 
that automates the process of creating those files and naming them correctly. You 
can download the script at http://cookbooks.adobe.com/post_Audio_Player_SkinMaker_
script-19701.html. That page includes instructions for installing and using the script.
Thanks, Adi!

Other panel settings
Auto Play: This setting is the same as Play on Page Load in the Media panel. 
It causes the sound to play when the user turns to that page. 
Delay: If you set Auto Play in the Folio Overlays panel or Play on Page 
Load in the Media panel, only the Folio Overlays panel allows you to 
set a [delay] before the audio plays. It’s usually a good idea to set a brief 
delay, even .125 seconds, so that the audio does not start playing before 
the page loads.

Use the Folio Overlays panel to set a delay on Auto Play, which helps prevent the audio file 
from playing before the page is fully loaded.

It’s easy to include video files in DPS apps. As with audio files, choose the 
File > Place command to position a video file in your layout. For DPS apps, 
it’s usually best to use a video file in MP4 format with H.264 encoding, 
which is compatible with Apple iTunes. Some of the settings for video 
will be set in the Media panel (see Chapter 2), and others will be set in the 
Folio Overlays panel.

It’s most efficient to use a video that is the exact proportion and size 
in pixels as it will appear when played. For full-screen videos, make the 

Working with 
video overlays

http://cookbooks.adobe.com/post_Audio_Player_SkinMaker_script-19701.html
http://cookbooks.adobe.com/post_Audio_Player_SkinMaker_script-19701.html
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width the number of pixels of the device you’re targeting; for the iPad 
and iPad 2, for example, make the video 1024 pixels wide.

After you place the video, select it and open the Media panel. Select 
the Play on Page Load check box. This automatically turns on the video 
Auto Play option in the Audio & Video section of the Folio Overlays panel. 
You can also use the Media panel to set a poster for your video: None, 
Standard, a frame from the video, or an image file. The Loop option is 
not honored in DPS at this time.

Many of the settings for video files are controlled in the Media panel, which is used in con-
junction with the Folio Overlays panel to specify the appearance of your video.

You can use the Media panel to set the appearance of the controller for 
the video, with controls for play, pause, and volume. You can also create 
buttons with actions assigned that play or pause the video, as described 
in Chapter 2.

The Folio Overlays panel options are a little different than those in the 
Media panel. Both panels are used to control how video behaves in your 
DPS app. The Folio Overlays panel includes three options for controlling 
video behavior.

Panel settings
Auto Play: While setting Play on Page Load in the Media panel sets Auto 
Play in the Folio Overlays panel, and vice versa, it’s only in the Folio 
Overlays panel that you can set a Delay before the video plays. It’s a good 
idea to set a brief delay, even .125 seconds, so that the video does not start 
playing before the page fully loads.
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With these settings for video files, you can set a delay or specify whether the movie takes up 
the full screen when it plays.

Play Full Screen: This setting lets you specify that the video play in full-
screen mode, whether via Auto Play or a tap on the screen. To return 
to the page after the video plays, the user taps the Done button in the 
upper-left corner of the screen.
Tap to View Controller: Setting this causes the controller to display when 
the user taps the video poster.

If you want to put an icon or other visual cue on top of the video file, 
simply place the icon on top of the video. When the user taps the video, 
the video, which is in a overlay, will move above the icon image and cover 
it while it is playing. When it is done, it will revert to the first frame of 
the video, with the icon image on top.

Place a visual prompt or icon on top of the video in InDesign (top). In the DPS app, the image 
will be visible on the video. When the user taps, the video plays in an overlay and the icon is 
hidden.

Panoramas let you put the user “inside” a locale and experience it as 
though the scene were viewed from a fixed location, looking around in all 
directions. For example, you could be inside a car and look around 360° 
or zoom in on the dashboard.

Creating panoramas
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To create a panorama, you need six images that represent the six inte-
rior surfaces of a cube. If you have an existing panorama photo or image, 
convert it to six images. You can use Photoshop to stitch images together 
to create the initial panorama. Then you can convert the panorama to the 
required six images using a third-party utility such as Pano2VR, which is 
available in Apple’s App Store.

Images required to make a panorama. They show north, south, east, west, top, and bottom. Use the Folio Overlays panel to set 
exactly which parts of the images can be viewed.

Source files must be in JPEG or PNG format. Source files are not com-
pressed by InDesign in any way, so to keep file sizes reasonable, use JPEG 
files with medium compression. The size of the panorama on the DPS page 
is determined by the first image, and the closer you can make the source 
images to their final sizes, the more efficient your final file size will be.

The six files must be named with ascending numbers, such as pan01.
jpg, pan02.jpg, pan03.jpg, and so on. Copy all six images into their own 
folder, with no other files.
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To import the images, click the Load Images folder icon in the Panorama 
section of the Folio Overlays panel and point to the folder containing the 
images. By default, the first image in the sequence will be used as the 
poster. Once this image is on the page, you can resize it as you would any 
graphic. However, as mentioned, it’s best if the image is already sized.

Panorama images are imported using the Folio Overlays panel. The panel also includes set-
tings for controlling what the user sees in the panorama.

Panel settings
Use First Image for Poster: Selected by default. If you wish to use another 
image for the poster, choose File > Place to position it in the frame that 
will contain the six images.
Initial Zoom: This sets the initial zoom of the images when the user taps 
the panorama. Use a setting between the minimum zoom (30 percent) 
and the maximum zoom (80 percent).
Vertical/Horizontal: This lets you specify values that determine which area 
of the panorama is initially displayed. For Vertical, you can specify a 
value from –90 (tilted all the way up) to 90 (tilted all the way down). For 
Horizontal, specify a value from –180 (rotated all the way left) to 180 
(rotated all the way right). The default of 0 (zero) sets the first image to 
display initially.
Field of View: This setting relates to how much the user can zoom in or 
zoom out, not to rotation.
Limit Vertical Pan: This setting limits the vertical tilt of the panorama. If 
you don’t want users to be able to tilt through the image until it’s upside 
down, set it to at least –1 and 1.
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Limit Horizontal Pan: This limits how far the user can view the panorama 
to the left and the right.

Web Content overlays allow users of your app to access all the resources of 
the web. Web Content overlays can be used for websites, RSS and Twitter 
feeds, or local HTML files.

To create an overlay to a website, first draw a frame of the dimensions 
and location of the desired view area. If you want to display a poster before 
the website displays, place an image in the view area frame; if you want 
the website to display when the page loads, leave the view area frame 
empty. The user’s computer must have an Internet connection in order 
for the webpage to load.

InDesign 
layout with 
Folio Overlays 
panel settings

Tablet app 
page before 
and after user 
taps web area

To display a webpage from an external URL, type the URL in the Web Content section of the 
Folio Overlays panel.

Type the URL of the website into the panel. Remember, since your 
viewers will be using an iPad, you’ll want to send them to the mobile ver-
sion of the website (if there is one); for example, http://mobile.twitter.
com/username. 

If you want to display a local HTML page, draw an empty frame or a 
frame with a placed poster image for the viewing area. In the Web Con-
tent section of the Folio Overlays panel, click the URL or File folder icon 

Web Content overlays

http://mobile.twitter.com/username
http://mobile.twitter.com/username
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and browse to the HTML file. The HTML file should be in its own folder, 
along with any resources, including images or scripts, that the HTML 
file refers to. 

You can use this feature to display things like a Google map or Twitter 
widgets. Copy the code from the Google or Twitter page, save it in a file, 
and point to the file in the Folio Overlays panel.

A local HTML file should be in a folder with any assets or scripts the file refers to.

As shown in the table on page 131, InDesign animations are not currently 
supported in DPS. Animations in DPS can play only if they are converted 
to HTML5 files. You can start with InDesign’s native animation features, 
discussed in Chapter 2, but then you must convert them HTML5 files. 

One way to do this is to export your InDesign animations as Flash files 
(FLA format) and convert them using Adobe’s experimental application 
Wallaby, available from Adobe Labs (http://labs.adobe.com/technologies/
wallaby/). Watch a video overview of this process on Adobe TV, at http://
adobe.ly/jWXPD8. 

Alternatively, you can create the animations in Adobe’s Edge software 
and save them to HTML5 in Edge’s OAM file format.

Once the files have been converted to HTML5, the Web Content overlay 
option is used to display and play the animation. 

Panel settings
Once you’ve set the URL or local file that the user will view in the view 
area frame, several settings can be adjusted in the Web Content overlay:
Auto Play: This setting will cause the webpage to load when the user turns 
to the page, without any tap necessary. You can also set a delay; it’s a 
good idea to set a small delay so the page doesn’t load before the rest of 
the app page appears.
Transparent Background: Select this option to set that the transparent 
background in a webpage be preserved. If this option is deselected, the 
web content background is used.
Allow User Interaction: This option lets the children play; that is, it lets the 
user interact with the displayed webpage, allowing them, for example, to 
click links and go to another page.
Scale Content to Fit: This option will cause the webpage to fit to the dimen-
sions of the view area frame that you created. Be sure the frame is large 

http://labs.adobe.com/technologies/wallaby/
http://labs.adobe.com/technologies/wallaby/
http://adobe.ly/jWXPD8
http://adobe.ly/jWXPD8
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enough that the webpage is still readable when it’s inside the frame. If 
you do not select this option, the webpage will be displayed at actual size 
and will be cut off if the frame is not large enough to view the page, and 
in most cases users will need to scroll in both directions to view the page.

Pan & Zoom overlays allow your users to explore an image beyond what 
is displayed in the static view. Specifically, it makes a large image available 
in a small view area, allowing the user to tap the image and then pinch 
to zoom in or out, and move to parts of the image that are not seen in 
the static view.

To create an image for Pan & Zoom, make sure the image has the exact 
dimensions you want to use. For example, if you want users to be able 
to pan a 1024 x 1024 pixel image in a 300 x 300 pixel view area, create a 
PNG or JPEG image that is 1024 x 1024 pixels in 72 dpi. You can do this 
using Photoshop or Illustrator: Choose File > Save for Web & Devices, 
then specify the dimensions.

Draw a frame that will define the dimensions of the view area, and 
then place the image inside the frame. The image should be larger than 
the view area frame. Position the image so the view area contains the 
appropriate part of the image. Try to select a focal point or some part of 
the image that is interesting on its own. The image in the view area will 
essentially become the poster image.

View area frame

The view area (left) and the full image (right), which the user will be able to experience with 
Pan & Zoom enabled.

Once the image is positioned, select the image, including the view 
area frame. Use the Pan & Zoom section of the Folio Overlays panel to 
turn Pan & Zoom on.

Pan & Zoom overlays
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The Pan & Zoom settings simply allow you to turn Pan & Zoom on or off for a selected image.

With Pan & Zoom, it’s particularly important to let the user know 
that the images are not static images. Clear instructions or icons should 
be included on the page. 

Once the user taps an image, the image can be scrolled or panned. 
The user can also pinch the image to see it reduced in the view area and 
visible in its entirety.

 

In this example, all three images are set to Pan & Zoom, and each image has been pinched and 
zoomed out to show the entire image. 

Scrollable frames are unique to tablet apps. They allow the user to view 
more content on the same page by scrolling that content within a fixed 
area. Scrollable frames can contain text, images, other overlays, or any 
combination of content.

Scrollable frames are created using a container frame and a content 
frame. The content is positioned in the container frame using the Edit > 
Paste Into command.

For example, to create a scrollable text frame, place the text you wish 
to scroll in its own frame on the page. Draw another frame that is the 
size of the area you wish to be visible.

Scrollable frames
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Content 
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Scrollable frames require both a container frame, which will be the viewing area, and a con-
tent frame, which contains the content that will scroll.

Next, position the content frame so it displays the part of the text that 
you want to be visible when the page opens, and position it where you 
want it to appear in the container frame. Select the content frame, and 
use Edit > Cut to move it to the clipboard. Select the container frame, and 
use Edit > Paste Into to position the content frame inside the container 
frame. You can adjust the size of the container frame, which determines 
how much of the content frame will display before the text scrolls.

Cut the content frame, select the container frame, and use Edit > Paste Into to position the 
content inside the container frame. 

Now you’re ready to select the container frame, with the content inside, 
and use the Scrollable Frame section of the Folio Overlays panel to change 
settings for the behavior of the content. 
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The Scrollable Frame section of the Folio Overlays panel with default settings.

Panel settings
Scroll Direction: These settings determine the scrolling action of the enabled 
frames. Auto Detect determines the scroll direction based on the height 
and width of the container frame and content frame. For example, if 
the heights of the frames are the same but the widths are different, the 
content scrolls only horizontally. To make sure that the content scrolls in 
only one direction — even if the container frame is narrower and shorter 
than the content frame — choose Horizontal or Vertical. Choosing the 
Horizontal & Vertical option allows the content to scroll in both direc-
tions, assuming the content frame is larger than the container frame.

The direction options for scrollable frames.

Scroll Indicators: Select Hide if you don’t want scroll bars displayed as the 
user scrolls the content.
Initial Content Position: Use this setting to determine the initial position 
of the content on the page. Select Upper Left to align the content frame 
to the upper-left corner of the container frame as the initial view. Select 
Use Document Position to use the location of the content frame as the 
initial view.
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The “sliding drawer” effect
Because scrollable frames can have any kind of content, you can do all sorts 
of fun things with them. One of our favorite tricks is to make a sliding 
drawer, or pull tab, effect. This lets you make tabs that users can drag out 
to reveal additional content. The following steps show just one example 
of the kinds of things that can be created using this general technique. 
It has the advantage, too, of allowing you to include more content in the 
relatively small amount of screen real estate available on tablets.

1. Create and group the objects that will make up the tab content. In 
this example, we have the tab graphic, some text, and an image.

The content of the tab is created, in this case, with the gray tab graphic, some text, and an 
image (left). The objects are positioned and grouped (right).

2. Draw the container frame. Since our tab will pull out from the right 
side of the page, the height of the container frame should be the 
same as, or a little greater than, the content group. With a typical 
scrollable frame, at this point the content group would be cut and 
pasted into the container frame. But if we do that, the tab will not 
have a pullout effect. There just won’t be that much room for the 
content to slide back and forth.

3. The trick to this technique is to draw an invisible rectangle that is 
positioned so that when it is grouped with the other content, the 
tab sits in just the right location in the container frame. This is 
illustrated on the following page.
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Content 
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Draw an invisible rectangle and group it with the other content, which positions the gray tab 
in the correct closed position. You can adjust the position later if necessary.

4. Group the rectangle with the other content, then select Edit > Cut 
to move it to the clipboard. Select the container frame and choose 
Edit > Paste Into to create the scrollable frame. You can click the 
content group and position it as needed once it’s pasted into the 
container frame. If the invisible rectangle is not in the correct 
position, double-click it to select it within the group and move it 
to the appropriate location.

Use Edit > Paste Into to position the content group in the container frame. If the tab location 
needs to be adjusted, double-click the rectangle to select it within the group and reposition it.

5. In the Folio Overlays panel, choose Horizontal from the Scroll 
Direction menu. And finally, select the Hide check box so that a 
scroll bar doesn’t appear when the user slides the tab out.
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The result, as viewed in the Desktop Viewer, is a pull tab, or drawer, that the user taps and 
pulls out to reveal the content. The tab can be moved back and forth at will by the user.

The Folio Builder Panel
The Folio Builder panel in InDesign is an essential part of creating a DPS 
app. The purpose of the Folio Builder panel is to assemble your documents 
into a folio file that can be converted into an app. The panel allows you to 
set properties for the folio; preview your work, including the interactive 
components; and share your folios with others for review.

The Folio Builder panel is used to create a folio file that will ultimately 
become a standalone app, such as a book or a single issue in a multi-issue 
app (as in a monthly magazine). Folios are made up of articles, which in 
turn are made up of layouts. Each folio may contain multiple articles. 
Each article may contain a layout that is horizontal only, vertical only, 
or one of each, depending on how the folio is set up.

Folio
Articles

Articles
Article

Articles

Articles

Articles

Articles

Vertical 
layout

Horizontal 
layout

A folio consists of articles, which are made up of InDesign layout files.

The Folio Builder panel is a multi-level panel. It displays folios when 
you are working on folios, articles when you are working on articles, and 
layouts when you are working on layouts. The key to using the panel is to 
pay attention to the label at the top of the panel, which tells you which 
level is being displayed.

Exploring the Folio 
Builder panel
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The key to using the multi-level Folio Builder panel is to keep an eye on the top of the panel, 
which shows you if you are viewing folios (left), articles (center), or layouts (right).

To navigate to the next level, click the arrow to the right of the folio 
or article, or double-click the folio or article name. To go back up from a 
layout or article, click the left-facing arrow at top. 

When you are viewing folios and articles, the bottom of the panel will 
have a Preview button, a New or Add button, and a Trash Can icon to 
delete folios or articles. When viewing layouts, you can Add a layout only 
if you are missing either the horizontal or vertical version.

The buttons at the bottom of the Folio Builder panel let you preview the entire folio (left), an 
article (center), or an individual layout (right).

When you have a list of multiple folios, you can filter which ones are 
displayed. At the top of the panel, click the black triangle next to Folios: 
All. You’ll see a list of the various kinds of folios that can be listed. The 
default setting is In the Cloud (that is, uploaded to the Acrobat.com web 
host), but there are other options that are discussed later in this chapter. 
Regardless of how you filter the list, you can also sort the list of folios 
alphabetically, by most recently modified, or by publication date.
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You can filter the kinds of folios that are displayed in the Folio Builder panel, and sort the 
filtered list.

The first step to creating a folio is to open the Folio Builder panel (Win-
dow > Folio Builder) and log in with your Adobe ID. If you already have an 
Adobe ID you wish to use, choose Sign In from the panel’s flyout menu; 
choose Sign Up if you don’t have an Adobe ID or want to create a new one. 

DPS and your Adobe ID
If you’ve ever registered your Adobe software, you have an Adobe ID. It’s free and is 
your usual “identifier” to Adobe. Most people have just one Adobe ID.
However, be aware that the Adobe ID you use in the Folio Builder panel will be tied 
to a specific custom viewer app that is created later in the process. This means that if 
you have different publications, you’ll want to sign in using different Adobe IDs. The 
folio you create may be a standalone app, such as a book, or it may be a single issue in 
a multi-issue app, such as a monthly magazine. Either way, the steps to create a folio 
are the same, but only one Adobe ID can be associated with a publication’s viewer app.

Next, click the New button at the bottom of the Folio Builder panel 
to display the New Folio dialog box. Here you will set various important 
attributes of the folio, including the Name of the folio. The name of the 
folio will be used for production purposes, and is not the name users will 
see in the final app. 

You can also specify the Viewer Version. The viewer version is associated 
with the version of any viewer app you’ve previously built, or the Adobe 
Content Viewer on your device used to preview your work. To change the 
version for the folio, click on the version number in the New Folio dialog 
box; the Viewer Version dialog box will display, then select the appropri-
ate choice. You’ll want to make sure that your folio is an equal version or 
lower than any viewer app you’ll want the folio viewed in.

TIP To determine the version of the Adobe Content Viewer on your tablet 
device, go to any app in the Library. Tap once to display the navigation controls, 
then tap twice on the name of the publication at the top of the screen. The 
version and build number will display.

Creating a folio
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Specify the Size of the folio, which should be the same aspect ratio 
as your articles. The folio doesn’t need to be exactly the same size, but 
the same aspect ratio is important; for example, 4:3 for iPads or 16:9 for 
Android tablets. You can also set the Orientation of your folio to contain 
only horizontal, only vertical, or both horizontal and vertical articles.

By default, when you create a folio it is uploaded to the Acrobat.com 
web host. However, if you don’t need to share the folio or preview it on 
another workstation, you can select the Create Local Folio check box. 
This will save the folio to your local hard drive, a good alternative when 
you want to work quickly or don’t have an Internet connection. Local 
folios are indicated by a disk icon  next to them.

The New Folio dialog box lets you define several important settings for your folio, including 
size, orientation, and image format.

Image format options let you specify the format of the flattened part 
of the folio. Remember that your InDesign layout is flattened to an image, 
with the interactive elements in an overlay. The options are JPEG, PNG, 
and PDF. 

JPEG creates an efficient file size and is ideal for most tablets. You can 
also set the Default JPEG Quality, or compression, to Minimum, Low, 
Medium, High, or Maximum; the default is High, which gives good results 
on most devices. This setting can be changed when adding new articles 
to the folio. PNG format is required, however, for transparency effects. 

PDF folios are often the best choice, because they hold their resolution 
regardless of the device resolution. PDF folios work best for the Retina 
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display on the third-generation iPad, but they can also be used for the iPad 
1 and 2. However, at this time PDF folios do not preview in the Desktop 
Viewer, which means they must be uploaded to the cloud in order to be 
previewed. This is cumbersome and takes time for each preview.

Adding a single article
Once you’ve created a folio, you can add the currently active InDesign 
document to the folio as an article. Click the folio name to go to the 
Articles level, then click the New button at the bottom of the panel. This 
displays the New Article dialog box.

The New Article dialog box lets you name an article, and if you have used alternate layouts for 
the two orientations, it will load them automatically.

In this dialog box, specify a Name for the article. This does not have 
to match the document file name and should relate to the content of the 
article in some way. This name is also used for creating links between 
articles, but it is not displayed to the end user in the viewer app. For 
instance, an article called “How to Train Your Cat” might be named “Cat” 
in the Folio Builder panel.

You can also specify the Default Format of the non-overlay components 
of the article: JPEG, PNG, or PDF.

If your InDesign document uses alternate layouts and contains both 
horizontal- and vertical-orientation pages, these will be automatically 
loaded for the Portrait Layout and the Landscape Layout. If the InDe-
sign document is set up as a long scrolling page, you can turn on Smooth 
Scrolling for the page; the default is Off (Snap to Page).
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If your InDesign file contains only one orientation, open that file or 
make it the currently active document file, and then create a new article. 
When you click OK, the file is added to the article and the orientation of 
the document is determined automatically. Once that file is loaded, make 
the file with the other orientation the active document. Then double-click 
the name of the article in the Folio Builder panel and click the Add but-
ton. The file will be added and the orientation automatically determined.

If you have only one orientation layout in each InDesign file, make one orientation active and 
create a new article, then make the other orientation file active and click the Add button.

Importing articles
Instead of adding articles one by one, you can import a folder of several 
articles at once. The file names and organization on your hard drive must 
be very specific, however. Start with a folio folder that contains article 
folders. When you import, you’ll point to the folio folder.

The folders for articles with both horizontal and vertical orientation 
must contain two InDesign files. One must have an _h suffix and one 
must have a _v suffix, such as filename_h and filename_v. If the article 
has a single orientation, the InDesign file within the article folder must 
have the correct orientation suffix.
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The file structure and naming conventions must be very specific in order to import articles.

To import articles, first create a folio in the Folio Builder panel. Next, 
choose the Import command from the flyout menu on the panel. You can 
import one or more articles.

To import multiple articles into a folio, choose the Import command and target the folio 
folder containing the article folders.

Once InDesign has imported the article folders, the articles are listed 
in the Folio Builder panel. You’ll still need to modify the article proper-
ties, as discussed in the next section.
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The imported folders are added as articles and will appear in the articles list for the folio.

After you create a folio, you can set the properties for the folios and 
articles. These properties specify what will appear in the app and be seen 
by the user, unlike the production-related settings you assign when first 
creating the folio.

Setting folio properties
To access the Folio Properties dialog box, click the name of the folio in the 
Folio Builder panel. From the flyout menu, choose Properties.

Folio properties are set after the folio is created and can be accessed from the flyout menu in 
the Folio Builder panel.

Setting folio and 
article properties
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Use the Folio Properties dialog box to set the Publication Name of 
the folio; this is the name that the user will see in the viewer app and 
is different from the folio name in the Folio Builder panel. You can also 
change the Viewer Version number, which specifies the version of the 
viewer app your folio will be viewed in. Be sure the version number of the 
folio is equal to or lower than the version of the viewer app.

Use the Folio Properties dialog box to set the name and to preview the icons that will appear 
in the viewer app.

The folio is represented in the viewer app library by a preview image. 
These images should be 72 dpi JPEG or PNG files and the same pixel 
dimensions as your folio, such as 1024 x 768. To load the preview, click the 
Folder icon and point to the image file. If you want to change the image, 
select it, click the Trash Can icon to delete the image, and load a new one.

Setting article properties
As with folio properties, the information and images in the Article 
Properties dialog box will be seen by the user in the viewer app. Article 
properties you can add include information like that often seen in print 
publications, such as the title and the author’s name (byline), along with 
additional information about the content.

To access the Article Properties dialog box, click the name of an article 
in the Folio Builder panel. Next, choose Properties from the flyout menu.
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The Article Properties dialog box is displayed by clicking an article and choosing Properties 
from the flyout menu.

The Title of the article is displayed when in Browse mode in the viewer 
app and also in the table of contents. The title here is different from the 
name of the article used in the Folio Builder panel; the article name in 
the Folio Builder panel is used for creating links between articles but is 
not displayed to the end user in the viewer app.

➍ ➀
➊

➁

➂

➃

➌
➋

 

The Article Properties dialog box lets you specify the title, description, byline, and kicker that 
will display for each article in the viewer app.

The Description of the article will appear above the article in the 
viewer app. This text could be similar to what’s called a deck in magazine 
articles — text that usually sits between the title and the body text — and 
further explains what the article is about.
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If you’re working with an article that you want to scroll as one long page, 
change Smooth Scrolling to the direction you want it to scroll. If you have 
an article made of individual pages, you can set them to Horizontal Scroll, 
which causes the pages to no longer display vertically within an article, 
but horizontally only, so the user goes through the article page by page.

The Byline will appear below the title in the viewer app. The byline is 
usually where the author’s name would appear.

The Kicker will appear above the title in the viewer app. It will also 
display above the title in the table of contents. This is often used to des-
ignate the different sections in a publication, such as Departments or 
Features. But this is not a hard and fast rule, and you can use it for any 
text that makes sense in this context.

The Kicker and Title text display in the table of contents in the viewer app, along with the 
thumbnail preview specified in the Article Properties dialog box.

To specify an image for the table of contents thumbnail, click the folder 
icon next to Table of Contents Preview. Select an image that is 70 x 70 
pixels and 72 dpi, in JPEG or PNG format. If you don’t specify an image 
in the Article Properties dialog box, a table of contents icon is automati-
cally generated from the first page of the article.

If your folio contains a page that is an advertisement that you don’t 
want to appear in the table of contents, select the Advertisement check 
box. If it’s some other kind of article you don’t want to appear in the table 
of contents, select the Hide From TOC check box.

It’s important, of course, to be able to preview your folios, articles, and 
interactive layouts. But even single pages, if they contain interactive set-
tings or elements created using the Folio Overlays panel, will not preview 
in the SWF Preview panel. Instead, use the Folio Builder panel to access 
the Adobe Content Viewer.

There are two versions of the Adobe Content Viewer: a desktop applica-
tion and a mobile device application. The Desktop Viewer is automatically 
added to your computer when you install the Folio Producer tools. The 
viewer for mobile devices is available for download in the Apple App Store, 
Google Play, and Amazon’s Appstore for Android. 

Previewing folios 
and articles
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Preview on your computer
The desktop version of the Adobe Content Viewer provides a quick and 
easy way to preview folios, articles, or even individual pages in your layout, 
right on your computer screen. 

It does have some limitations, though. You cannot preview an entire 
folio at once if it contains both dual-orientation articles and single-
orientation articles. But you can still preview individual articles within 
the folio. Another limitation is that you cannot preview PDF folios, at 
least at the time of this writing.

To preview a folio, select it in the Folio Builder panel. At the bottom of 
the panel, click Preview to display the menu. Choose Preview on Desktop 
to display in the Desktop Viewer on your computer.

The Desktop Viewer displays the folio and all its articles. There are sev-
eral shortcuts you can use to mimic viewing the folio on a mobile device. 
Use Cmd/Ctrl with the + and – keys to simulate pinching in and out.

The Desktop Viewer uses keyboard shortcuts to allow you to view a folio as you would on a 
mobile device.

TIP Use Cmd/Ctrl-R to rotate orientation in the Desktop Viewer.

To view an article in the Desktop Viewer, select the article in the Folio 
Builder panel and click the Preview button at the bottom of the panel. 

If you’re working with 1024 x 768 pixel documents, you can also pre-
view your current open InDesign file. Choose File > Folio Preview, and the 
Desktop Viewer will preview the file. This will preview the file even if it 
hasn’t been added to a folio and can come in handy when you don’t have 
an Internet connection and can’t get to your folio in the cloud.

Folio Preview lets you preview your current layout file in the Desktop Viewer.

You can control the image format of the Desktop Viewer by choosing 
File > Folio Preview Settings and selecting the image format in which to 
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display previews. Select Preview Current Layout if you want the Desktop 
Viewer to display only your current layout.

You can also preview the interactive content on your current page 
using the Folio Overlays panel. Click the interactive content on the page 
to access the appropriate section of the panel, then click Preview at the 
bottom of the panel.

The desktop version of the Adobe Content Viewer is a good “quick 
and dirty” way to preview your work, but it doesn’t precisely emulate 
the experience your users will have when viewing your app. You should 
always check your work periodically by previewing it on the target device.

Preview on your device
You can also preview folios and articles on an iPad, an iPhone, or Android 
tablets. That way, you’ll know exactly how your app will look and feel on 
its destination device.

There are two different ways you can preview folios. In both cases, 
you must have the Adobe Content Viewer installed on the target device. 
Download the app from the appropriate store for your device.

You can preview your folios from the cloud (that is, on Acrobat.com). 
Simply go to the Adobe Content Viewer on your device and log in with 
the same Adobe ID you used to create your folios. Once you sign in, all 
your folios in the cloud will be available for downloading and previewing. 
Local folios will not be available for preview.

You can also preview your folios and articles without an Internet 
connection by connecting your iPad, iPhone, or Android tablet to your 
computer. To view your folio and articles, the device must be physically 
attached to your computer, and the Adobe Content Viewer must be open. 
To preview a folio, select it in the Folio Builder panel. At the bottom of 
the panel, click Preview to display the menu. Choose Preview on <device 
name>. The folio will appear in the Library window of the Content Viewer.

You can preview folios and articles by connecting your device to your computer, without any 
Internet connection required.

There are a couple of advantages to previewing on your device with a 
direct connection. For one, you can often preview folios and articles more 
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quickly, as no Internet connection is involved and you don’t have to wait 
for your articles to upload and then download. Also, you can preview local 
folios with a direct connection. 

Keep in mind that the Adobe Content Viewer is basically a generic 
version of an app viewer, and its primary purpose is for testing your 
digital content directly on the iPad, iPhone, or Android device. The Adobe 
Content Viewer is updated along with the Folio Producer tools, which are 
updated frequently. 

While the ultimate goal of your tablet app is its publication to a wide audi-
ence, it’s also important to be able to share your interactive content with 
others who are part of a smaller group, especially during the development 
process. Fortunately, the Folio Builder panel makes it easy to share folios 
and articles with other members of your workgroup or with your client.

To share a folio, select it in the Folio Builder panel and choose Share 
from the flyout menu. The dialog box that is displayed lets you send an 
email to the person, or group of people, with whom you’d like to share 
the folio. You can input multiple email addresses separated by commas. 
The default subject line reads “<your name> has shared a folio with you.” 
Fill out the Message field to include a message with the email. Click the 
Share button, and an email will be sent to the addressee(s).

The Share option in the flyout menu of the Folio Builder panel lets you send an email to mem-
bers of your workgroup or to your client, allowing them to preview the folio.

Once you’ve shared a folio, the folio name will be displayed with a 
share icon . Hover your cursor over the folio name to display a tool 

Sharing folios
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tip that includes information about the folio, its owner, and how many 
people have shared it.

A tool tip displays information about the folio, such as that it has been shared with one 
person.

The person with whom you’ve shared the folio must log in using their 
Adobe ID in order to view the shared folio. In fact, you must send the 
email to the email address used by their ID in order for them to be able to 
view the shared folio. The folio will be available in the Folio Builder panel 
on their copy of InDesign, as well as in the library of the Adobe Content 
Viewer on their iPad or Android tablet.

If you want to stop sharing a folio, choose Unshare from the flyout 
menu on the Folio Builder panel. A dialog box displays a list of all the 
users sharing the folio. You can unshare with any individual member of 
the list or unshare the folio from the entire list.

If someone shares a folio with you, that folio will display in your Folio 
Builder panel and in the library of your device’s Adobe Content Viewer. 
You’ll see the folio in your Folio Builder panel list with the share icon 
next to it, but when you go to the articles list, the article names will be 
grayed out (meaning you cannot change them, but you can preview them). 

TIP You cannot share local folios from the Folio Builder panel. Instead, move 
them to the cloud. From the flyout menu on the Folio Builder panel, choose 
Upload to Folio Producer, which puts the folio in the cloud so it can be shared.

Sharing folios is the method used by advertisers to submit ads to 
publications. The advertiser shares the ad folio with the publication. The 
ad can then be added to the publication’s folio in Folio Producer, the next 
step in the publishing process.
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Folio Producer
After you’ve created your interactive content and added your folios with 
articles to the Folio Builder panel, the next step toward creating an app 
is to upload your content to Folio Producer. Folio Producer is a web-based 
tool that allows you to organize, edit, share, and publish the folios you’ve 
created in InDesign. It’s part of the DPS Dashboard, which contains several 
tools and resources for publishing your app.

Because the focus of this book is on the tools in InDesign, we’ll just 
give you a quick overview of Folio Producer to get you started exploring 
on your own.

To access Folio Producer, choose Folio Producer from the flyout menu 
on the Folio Builder panel or use your computer’s browser to log in to the 
DPS Dashboard at http://digitalpublishing.acrobat.com. Log in with the 
same Adobe ID you used to create your folios in the Folio Builder panel in 
InDesign. Anyone with a valid Adobe ID can log in to the DPS Dashboard, 
but certain options are available only to DPS subscribers.

Sign in to the DPS dashboard using the same Adobe ID you used to create your folios in the 
Folio Builder panel in InDesign.

From the Dashboard, click Folio Producer. You will now be in the Folio 
Producer Organizer and will see a list of all the folios you created in the 
Folio Builder panel in InDesign. From this list view, you can specify vari-
ous settings for the folio, such as the Publication Name and the Folio 
Number. Settings that are marked with an asterisk are required to publish 
the folio. Any changes you make here are updated and show in your Folio 
Builder panel in InDesign. 

You can also share the folio from here by clicking the Share icon  
at the top of the window. Just as when sharing from the Folio Builder 
panel, you’ll get an email you can address to invite others to share the folio.

http://digitalpublishing.acrobat.com
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The Folio Producer Organizer lists all the folios from your Folio Builder panel in InDesign. 
Changes made here are reflected in the folios in the Folio Builder panel.

If you have local folios you want to work with in Folio Producer, you 
must upload them. Click the name of the local folio and choose Upload 
to Folio Producer from the flyout menu. The list in Folio Producer will 
be updated to include the local folio.

To list local folios, upload them to Folio Producer from the Folio Builder panel in InDesign.

You can use the Folio Producer Editor to rearrange articles, move 
articles to and from other folios, and change article settings. To access 
the Editor, click the name of a folio in the Organizer list and click Open.

You can work with articles in either a thumbnail view or a list view. 
To change the article properties, click an article and edit the information 
shown on the right side of the window.
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The Folio Producer Editor lets you rearrange articles or change article properties.

You can still edit your InDesign documents after you have done work 
on them in Folio Producer. From InDesign, choose Update from the flyout 
menu on the Folio Builder panel.

Once your folio is organized the way you want it, you can publish 
your folio to the Adobe Distribution Server. This option is available to 
anyone and does not require a DPS subscription. Simply click the name 
of the folio in the Folio Producer Organizer window, then click Publish. 
Once the folio is published, you can download it to your device’s Adobe 
Content Viewer and experience the app exactly as your users will see it.

If you have a DPS subscription, you will need to embed this published 
folio in your custom viewer app. The folio is embedded in the viewer app 
as a ZIP file. To create this ZIP file, click the Export button in the Folio 
Producer Organizer window.

The final step in Folio Producer is to export your folio as a ZIP file that can be embedded in 
the app.
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Think of the Folio Producer as a bridge between the production of your 
folio and the actual app development, which requires a DPS subscription. 
The app development is the final step in making your app available for 
sale to the general public.

What’s Next: Publishing Your App to a Store
The final step to selling your app to the public is to turn it into an actual 
device application. As we mentioned in the first chapter of this book, 
designers and creative professionals are expected not only to be creative 
and produce documents, but also to become application developers. Details 
of the process are beyond the scope of this book, but we offer an outline 
of what’s involved to get you started. 

Once you’ve published your folio and exported it, the next step is to 
build a viewer app. The Viewer Builder app can be downloaded from the 
DPS Dashboard, where you signed in for Folio Producer. Use the Viewer 
Builder wizard to name your app, add icons and splash screens, and point 
to the ZIP file of the folio created using Folio Producer.

If you are publishing to the iPad or iPhone, you’ll need to sign up to 
become an Apple Developer. The cost is $99 a year, and you can sign up 
at https://developer.apple.com/programs/ios/. 

Amazon has its own requirements for developers for the Kindle Fire, 
details of which can be found at http://developer.amazon.com/. There is 
yet another set of guidelines for Android developers, which can be found 
at http://developer.android.com/index.html.

Resources
As mentioned at the beginning of this chapter, the details of creating apps 
using the Digital Publishing Suite are quickly changing. The features of the 
Folio Builder panel and Folio Producer, the details of DPS subscriptions, 
and the final process of development will all change frequently. 

Here is a list of important resources that will supplement this book 
and bring you the most up-to-date information about DPS.

■■ Robert Bringhurst, author of the documentation for InDesign and 
the Digital Publishing Suite, has created a fantastic publication 
app for the iPad called DPS Tips. It’s a must-have app if you want 
to learn more about DPS: http://itunes.apple.com/us/app/digital-
publishing-suite-tips/id436199090?mt=8

■■ The Adobe Help files for DPS are available online: http://help.adobe.
com/en_US/digitalpubsuite/home/

https://developer.apple.com/programs/ios/
http://developer.android.com/index.html
http://developer.amazon.com/
http://itunes.apple.com/us/app/digital-publishing-suite-tips/id436199090?mt=8
http://itunes.apple.com/us/app/digital-publishing-suite-tips/id436199090?mt=8
http://help.adobe.com/en_US/digitalpubsuite/home/
http://help.adobe.com/en_US/digitalpubsuite/home/
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■■ The DPS Developer Center has fantastic resources, including white 
papers and videos: http://www.adobe.com/devnet/digitalpublish-
ingsuite.html

■■ There are many excellent videos covering DPS on Adobe TV: http://
tv.adobe.com/product/digital-publishing-suite/

■■ Adobe provides a gallery of all the publications that have created 
DPS apps — a great source of inspiration, and a list that is growing 
daily: http://blogs.adobe.com/digitalpublishinggallery/

■■ Don’t forget to check out our blog. We’ll add information as it 
becomes available on new features and processes for creating tablet 
apps using DPS: http://www.indesigndigitalpublishing.com/ 

http://www.adobe.com/devnet/digitalpublishingsuite.html
http://www.adobe.com/devnet/digitalpublishingsuite.html
http://tv.adobe.com/product/digital-publishing-suite/
http://tv.adobe.com/product/digital-publishing-suite/
http://blogs.adobe.com/digitalpublishinggallery/
http://www.indesigndigitalpublishing.com/
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A
accessibility 

considerations, 52
of PDF files, 232

Adobe Content Viewer, versions of, 167
Adobe Digital Editions ePub reader, 203
Adobe Dreamweaver ePub editor, 207
Adobe Illustrator, creating audio controllers 

with, 144
Adobe Media Encoder, converting files 

with, 45–46
Adobe Reader, downloading, 225
advertising designers, 4
Alternate Layouts, 91

creating, 96–97
linking between, 97–98
Liquid Layout menu, 97
master pages, 98
Name field, 97
options, 98
preset page sizes, 97
setting up Pages panel, 95–96
source page, 97
text styles, 98

Android 10”, dimensions and resolution, 93
Android developers, guidelines for, 175
animated objects, setting delay for, 82–83
animation order, changing, 83
Animation panel, opening, 66, 74
animation properties

appearance, 77–78
location, 78
opacity, 79
proxy, 79–80
Rotate controls, 78
saving custom settings, 80
Scale fields, 78–79
visibility options, 79

animation settings, applying motion presets, 74
animations. See also playing animations

availability, 21
Duration field, 75
explained, 21
exporting, 73

exporting to PDFs, 250–251
limitations, 21
motion paths, 80–82
naming, 74–75
playing together, 83–84
previewing, 84–87
rectangle frames, 74
removing, 82
Speed menu, 75
testing exports in browsers, 86
text frames, 74
timing, 82–84

Appearance controls, 27
Apple Developer, signing up as, 175
apps, publishing to stores, 175. See also DPS apps; 

tablet applications
article properties

Byline, 167
Description, 166
Kicker, 167
setting, 165–167
Smooth Scrolling, 167
Table of Contents Preview, 167
Title, 166

articles
adding to folios, 161–162
defined, 123
importing into folios, 162–164
jumping to articles, 134
previewing, 167–170

aspect ratios
automatic setting of, 94
comparing, 94
explained, 93–94

audio controllers, creating with Illustrator, 144
audio files. See also Media panel

adding to documents, 46
availability, 20
explained, 20
limitations, 20
setting poster for sounds, 47–48
setting sound options, 46–47

audio formats, 45–46
audio overlays, using with tablet apps, 141–144
AVI format, support for, 45
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B
Better Homes and Gardens magazine, 12, 14
blog, link to, 15
book designers, 5
book files

creating, 196
style source, 196
working with, 196–197

bookmarks
availability, 20
creating, 39–40
explained, 20
getting from TOC, 40–41
limitations, 20
nesting, 40
using, 39

Bringhurst, Robert, 175–176
bullets, including in PDF forms, 67
button effects

show/hide rollover, 58–60
showing object states, 60–63

button properties, removing from objects, 51
button states

applying text to, 57
deleting, 58
hiding, 58
Place command, 58
using imported images for, 57–58

buttons. See also Sample Buttons and Forms
adding events to, 52–53
Animation action, 54
appearances, 55–57
appearances versus actions, 57
applying actions to, 51
applying actions to events, 54–55
availability, 21
choosing actions for, 53–54
Click state, 55–56
comparing to hyperlinks, 51
converting objects to, 52
creating, 51
creating for DPS apps, 133–134
creating for PDF documents, 51
deleting actions for events, 55

explained, 21
Go To actions, 53–54
limitations, 21
naming, 51
Normal state, 55–56
for playing animations, 76–77
Rollover state, 55
Show/Hide actions, 53
Sound action, 54
Video action, 54

C
Calibre ePub reader, 203
Character Style menu, 26
Check Box form, described, 64
check boxes, using, 69
check marks, including in PDF forms, 67
clients, preferences of, 7
Cmd key. See keyboard shortcuts
column widths, setting, 117–118
Combo Box form, described, 64
combo boxes, using, 69–70
Content Conveyor, Map Styles option, 112
Content tools

Content Collector, 105
Content Conveyor, 106–107, 112
Content Placer, 105–106
linking objects with, 109
Load Conveyor, 107
using, 104–107

Content Viewer, versions of, 167
controller, setting for video, 49–50
cropping images, 116
cross-references. See also hyperlinks

appearance controls, 33
availability, 19
creating, 30–32
in ePubs, 31, 33
explained, 19
formatting text in, 32–33
limitations, 19
Link To options, 31
paragraphs, 32
pre-made formats, 33
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setting, 31
text anchors, 31–32
using, 30

Ctrl key. See keyboard shortcuts
Cunard customers, 6

D
days of month, form for, 70
deleting

hyperlinks, 28
object states, 44

designers
in-house marketing, 7
magazine, 5–7

dictionaries, availability of, 13
Digital Editions ePub reader, 203
digital publishing formats

DPS, 9
ePub, 9
FLA, 9
HTML, 9
PDF, 9
SWF, 9

Digital Publishing intent, using with tablet 
apps, 129

digital publishing 
standards, 14–15
terminology, 9

documents, previewing, 85
DPS (Digital Publishing Suite), 5

and Adobe ID, 159
animation support, 131
audio support, 131
button support, 131
hyperlink support, 131
support for native interactive features, 131
video support, 131

DPS apps. See also apps; tablet applications
creating buttons for, 133–134
including audio files in, 141–144
navigation, 124–125
user interface, 124–125

DPS format, 9
DPS resources, 175–176

DPS tools
Adobe Content Viewer, 121–122
Folio Builder panel, 121–122
Folio Overlays panel, 121
Folio Producer, 122
Viewer Builder, 122

DPS workflow
creation, 123
distribution, 123
production, 123

Dreamweaver ePub editor, 207

E
eBook, defined, 179
EPUB 3.0 standard, 198, 213
ePub CSS, editing, 208
ePub document pages

book files, 196–197
covers, 194–195
image-based breaks, 196
metadata, 197–198
page breaks, 195–196
Rasterize First Page option, 194
TOC (table of contents), 193–194

ePub editors
Adobe Dreamweaver, 207
Notepad++, 207
Oxygen XML Author, 207–208
Sigil, 207
TextWrangler, 207
using, 206–208

ePub export options. See also export options 
for HTML

Advanced pane options, 202–203
Bullets menu, 199–200
CSS Options, 202–203
embeddable fonts, 203
EPUB Metadata option, 202
General pane options, 198–200
Image pane options, 200–201
line breaks, 199
Margins setting, 199

ePub export options (continued)
Numbers menu, 200
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page breaks, 200
resolution, 200
Split Document option, 202
text options, 199
Version menu, 198

ePub files
adding properties to CSS, 210
anchoring graphics in text, 191–193
Articles panel, 184–185
cell styles, 187
changing standards, 213
character styles, 186
code knowledge, 188
Content.opf XML file, 206
converting to Kindle files, 211–212
correcting problems in CSS, 209–210
creating reader order, 183–185
creation process, 180–181
CSS folder, 206
CSS knowledge, 188
CSS resource, 211
distribution of, 5
document pages, 193–198
enhanced, 213
explained, 179–180
fixed-layout, 213
graphics, 190–193
HTML knowledge, 188
inline graphics, 190
layout order, 184
loss of information via exporting, 181–182
mapping styles to tags, 187–189
META-INF folder, 206
mimetype, 206
multimedia, 213
Object Export Options dialog box, 191–192
object styles, 187
OEBPS folder, 206
paragraph styles, 186
proofing, 203–204
stories, 183
structure, 205–206
styles, 186–189
tablet styles, 187
TOC.ncx XML file, 206
uncompressing, 204–205

unzipping, 205
validating, 204
workflow, 182–183
XML structure, 184

ePub format
explained, 8–9, 179–183
exporting files to, 213–214
features supported by, 180
Kindle restriction, 182

ePub readers
Adobe Digital Editions, 203
Calibre, 203
EPUBReader, 203
Ibis Reader, 204
iBooks, 203–204

export options for HTML, 216. See also  
ePub export options

Advanced pane, 219–220
Content Order, 217
Copy Images menu, 218
CSS code settings, 219–220
Export area, 217
Formatting, 217
General pane, 217
Image pane, 218–219
Link to Server Path, 219
Optimized, 219
Original, 218
preparing ePub files for, 215

Export SWF dialog box, 240
Export to Interactive PDF dialog box, 249
exporting. See also PDF export

animations into PDFs, 250–251
documents as SWF files, 239
FLA files, 246–247
InDesign animations, 73
with SWFPresenter, 250–251

exports, testing in browsers, 86

F
F4V format, support for, 45
FLA format

described, 9
exporting, 246–247
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Flash
importing presets from, 81–82
using, 241

FLV format, support for, 45
Folio Builder panel

buttons in, 158
features, 157–159
navigating, 158
opening, 159
previewing items, 158
using, 157
viewer version, 159

Folio Overlays panel, using with tablet 
apps, 131–132

Folio Producer
accessing, 172
changing article properties, 173
creating ZIP files, 174
Editor, 173–174
listing local folios, 173
Organizer, 173
using, 172–175

Folio Properties dialog box, accessing, 164
folios

adding articles, 161–162
article properties, 165–167
components of, 157
creating, 159–164
filtering display of, 158–159
image format options, 160
importing, 162–164
JPEG option, 160
PDF option, 160–161
previewing, 167–170
saving to local hard drive, 160
sharing, 170–171
sizing, 160
unsharing, 171

forms. See PDF forms; Sample Buttons  
and Forms

availability, 21
explained, 21
limitations, 21

frames. See also scrollable frames
modifying images in, 114–118
modifying text in, 114–118

G
Guide-based rule, using, 101–102

H
HTML export options. See also ePub export 

options; exporting
Advanced pane, 219–220
Content Order, 217
Copy Images menu, 218
CSS code settings, 219–220
Export area, 217
Formatting, 217
General pane, 217
Image pane, 218–219
Link to Server Path, 219
Optimized, 219
Original, 218
preparing ePub files for, 215

HTML format, 9
Hyperlink Options dialog box, opening, 27
hyperlink types, identifying, 26
hyperlinks. See also cross-references; Link To 

menu options
availability, 19
character style, 26–27
comparing to buttons, 51
creating, 21–23
creating destinations, 28
deleting, 28
destinations, 23
displaying, 26
editing destination options, 29
email destination, 23
explained, 19
fixing missing, 29
hotspot appearance, 27
inverting colors, 27
limitations, 19
navigating, 29

hyperlinks (continued)
page destination, 29
renaming, 26
source settings, 27
style and appearance settings, 26–27
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text anchor destination, 28
URL destination, 28
viewing in Story Editor, 30

I
Ibis Reader ePub reader, 204
iBooks ePub reader, 203–204
IDPF (International Digital Publishing Forum), 

179, 198, 204
Illustrator, creating audio controllers with, 144
image sequencing, using with tablet apps, 138–141
images

Auto-Fit options, 115–116
cropping, 116
modifying within frames, 114–118
resizing in frames, 116

importing
articles into folios, 162–164
presets from Flash, 81–82

InDesign
features, 10–11
as “hub”, 10

interactive elements
animations, 21
audio files, 20
bookmarks, 20
buttons, 21
cross-references, 19
forms, 21
hyperlinks, 19
multi-state objects, 20
page transitions, 21
table of contents, 20
video  files, 20

interactivity, using, 14
iPad

aspect ratio, 94
dimensions and resolution, 92
ICC profile, 127
interactive PDF files on, 225
templates, 129

iPhone, dimensions and resolution, 92

K
keyboard shortcuts

object states, 42
previewing documents, 85
previewing spreads, 85
Story Editor, accessing, 30

Kindle files, converting to, 211–212
Kindle Fire

aspect ratio, 94
dimensions and resolution, 92
requirements for developers, 175

L
layout controls

Alternate Layouts, 91, 95–98
comparing layouts, 114
linking items, 104–111
linking styles, 111–113
Liquid Layout rules, 98–104
Liquid Layout, 91
modifying images within frames, 114–118
modifying text within frames, 114–118
setting page sizes, 91–95

layouts
comparing, 114
Split Window feature, 114

LensWork magazine, 8
Level setting for TOC, 37
Life magazine, 19
Link Options

setting, 109–110
Story and Objects dialog box, 111
Story dialog box, 109–110

Link To menu options. See also hyperlinks
Email, 24
File, 23
Page, 24–25
Shared Destination, 25–26
Text Anchor, 25
URL, 23

linked text. See also text
releasing, 108–109
updating, 108
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linking
styles, 111–113
text, 108

Liquid Layout panel
opening, 99
using, 103

Liquid Layout rules
applying, 98–99
Controlled by Master, 99
Guide-based, 99, 101–102
limitations, 100
Object-based, 99, 102–104
Off, 99
Preserve Existing, 99
Re-center, 99–101
Scale, 99–100
Scale rule, 100
tips for use of, 103–104

Liquid Layouts
described, 91
Page tool, 98

List Box form, described, 64
Luce, Henry, 19

M
magazine designers, 5–7
Manage presets dialog box, 82
mapped styles, choosing, 113
marketing designers, in-house, 7
Media panel. See also audio files

previewing sounds, 47
setting sound options from, 46–47
using with videos, 48

months of year, form for, 70
motion paths

customizing, 81
editing, 80–81
importing presets from Flash, 81–82

motion presets, applying to animations, 74
MOV file format

support for, 45
use of, 50

movies
controlling in PDF documents, 50

previewing, 50
setting Poster menu for, 49

MP3 format, support for, 45
MP4 format, support for, 45
MPEG format, support for, 45
multimedia, adding, 12–13
multi-state objects. See also object states

Align Centers command, 41
availability, 20
creating, 41–42
editing, 42–44
explained, 20
hiding until triggered, 44
limitations, 20
previewing, 44–45
sizing, 41
stacking images for, 61
testing, 44

N
navto:// syntax, using with tablet apps, 134
Nook

aspect ratio, 94
dimensions and resolution, 92

Notepad++ ePub editor, 207
number styles, creating in TOC, 36

O
object states. See multi-state objects

converting, 44
creating remote rollovers with, 137–138
creating slideshows with, 135–137
deleting and removing, 44
displaying via buttons, 44
duplicating, 44
pasting objects in, 44

Object-based rule, using, 102–104
objects

animating, 74
converting to buttons, 52

objects (continued)
linking with Content tools, 109
placing in single state, 42
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playing together, 83–84
removing button properties from, 51

orientation of pages, changing, 117
overlays, using with tablet apps, 130
Oxygen XML Author ePub editor, 207–208

P
page numbers, controlling in TOC, 35–36
page sizes

aspect ratio, 93–94
customizing, 94–95
resolution, 91–93
screen dimensions, 91
setting, 91–95
setting and saving, 94–95
smartphones, 91–93
tablets, 91–93

Page tool, using with Liquid Layouts, 98
page transitions

availability, 21
explained, 21
limitations, 21

Page Transitions panel, using, 247–248
pages, thinking about, 12
Pages panel views

By Alternate Layout, 95
Horizontally, 95
Vertically, 95

Pan & Zoom overlays, using with tablet 
apps, 151–152

panoramas, creating for tablet apps, 146–149
PDF bookmarks, creating for TOC, 38
PDF documents

accessibility settings, 52
controlling movies in, 50
third-party readers, 224–225
viewing on Adobe readers, 224

PDF export. See also exporting
Acrobat layers, 228–229
creating pages, 228
creating spreads, 228
embedding page thumbnails, 228
forms, 231
Full Screen mode warning, 231

Interactive option, 226–227
Layout controls, 230
media, 231
Presentation controls, 230
Print option, 226–227
targeting pages, 227–228
View controls, 229
viewing after, 228

PDF files
accessibility controls, 231–235
allowed features, 238–239
Articles panel for accessibility, 233–234
Changes Allowed settings, 238
compression, 235–236
descriptions for accessibility, 232–233
exporting animations to, 250–251
image handling, 235–236
interactivity on iPad, 225
JPEG quality, 236
listening to, 231
locking, 236–237
Permissions password, 237–239
Printing Allowed controls, 238
Read Out Loud feature, 231
reading order for accessibility, 233
resolution, 236
Section 508 Accessibility, 232
security, 236–239
tab order for accessibility, 235
tagged PDF export for accessibility, 235

PDF format, 9
PDF forms. See also forms; Sample Buttons and 

Forms
applying actions to events, 65–66
bullets, 67
Check Box, 64
check boxes appearance states, 66–67
check marks, 67
Click Off state, 66
Click On state, 66
Combo Box, 64
creating, 63–68
formatting, 66
List Box, 64
Multiline option, 65
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Multiple Items option, 65
Normal Off state, 66
Normal On state, 66
Password option, 65
Printable option, 64
radio buttons, 64
radio buttons appearance states, 66–67
Read Only option, 65
Required option, 64
Rollover Off state, 66
Rollover On state, 66
Scrollable option, 65
Selected by Default option, 65
Signature Field, 64
Sort Items option, 65
text field, 64
types of, 64

PDF interactivity, previewing, 84
PDF open source standard, 224
PDF workflow, 223–225
People magazine, 6
Place command, using with button states, 58
planning ahead, 11
Play Separately icon, using with animations, 84
Play Together icon, using with animations, 84
playing animations. See also animations

creating button for, 76–77
and replaying, 75
setting events for, 75–76

Poster menu
setting for movies, 49
using with sounds, 47–48

presets, importing from Flash, 81–82
previewing

animations, 84–87
articles, 167–170
documents, 85
folios, 167–170
movies, 50
PDF interactivity, 84
spreads, 85
transitions on page, 249

print designers
considering pages, 12
responsibilities of, 11

thinking non-linearly, 11–12
publishing apps to stores, 175

R
radio buttons

accessing, 69
actions applied to, 66
form, 64
using, 69

readers
educating, 13–14
engaging, 13

Re-center rule, using, 100–101
remote rollovers, creating with object 

states, 137–138
resolution, explained, 93
Rollover or Click appearance, 58

S
Sample Buttons and Forms. See also buttons; 

forms
accessing, 68
button actions, 69
button types, 69
check boxes, 69
combo boxes, 69–70
days of month, 70
months of year, 70
radio buttons, 69

Scale rule, using, 100
screen size, aspect ratio for, 94
scrollable frames, using with tablet apps, 152–157. 

See also frames
Section 508 Accessibility, 52, 232
Sigil ePub editor, 207
Signature Field form, described, 64
slideshows, creating for tablet apps, 135–137
“sliding drawer” effect, using with tablet 

apps, 155–157
smartphone page sizes, finding, 91–93
sound files. See audio files
Split Window feature, using with layouts, 114
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Sports Illustrated magazine, 19
stories in ePubs, defined, 183
Story Editor, accessing, 30
style groups, using, 111–112
Style menu for TOC, 36
styles, mapping, 112–113
SWF files

exporting documents as, 239
Page Curl, 249–250
Page Turn, 249–250
previewing transitions on page, 249

SWF format
described, 9
support for, 45

SWF options
background color, 242
controlling pages, 240
Fit To menu, 242
flattening pages, 245–246
fonts, 244–245
frames per second, 243–244
generating HTML files, 240
image handling, 246
interactivity, 242
previewing without exporting, 246
rasterizing pages, 245–246
setting, 239–246
Size area, 241–242
text, 244–245
viewing after exporting, 241

SWF Preview panel, 45
Clear Preview button, 85–86
controls, 85
editing settings, 86
using, 84–85
using from other panels, 86–87

SWFPresenter, using, 250–251

T
table of contents (TOC). See TOC (table of con-

tents)
tablet applications. See also apps; DPS apps

audio overlays, 141–144
buttons vs. hyperlinks, 132–133

controller files for audio, 142–144
creating panoramas, 146–149
design considerations, 125–128
Digital Publishing intent, 129
document setup, 129–130
DPS (Digital Publishing Suite) apps, 121–125
Folio Overlays panel, 130–132
Folio Producer, 172–175
fonts, 127
horizontal orientation, 126
hyperlink for jumping to articles, 134
image sequencing, 138–141
images, 127
interactivity visual cues, 127–128
jumping to articles, 134
native interactive features, 131
navto:// syntax, 134
overlays, 130
page orientation, 126
“pages” concept, 125
Pan & Zoom overlays, 151–152
panel settings, 134
pre-set page sizes, 130
proofing, 128
publishing to stores, 175
remote rollovers with object states, 137–138
resources, 128
scrollable frames, 152–157
scrolling vs. individual pages, 126–127
slideshows with object states, 135–137
“sliding drawer” effect, 155–157
source images, 139
vertical orientation, 126
video overlays, 144–146
Web Content overlays, 149–151
workflow considerations, 128

tablet page sizes, finding, 91–93
tablets, dual orientation, 5
text. See also linked text

applying to button states, 57
modifying within frames, 114–118

Text Anchor hyperlink destination, 28
text controls, Auto-Size options, 116–117
text field form, described, 64
text frames, Flexible Width option, 118



Index

263

text styles
copying, 111
mapping, 112

TextWrangler ePub editor, 207
Time magazine, 19
Timing panel, opening for animations, 82
TOC (table of contents)

applying character styles to numbers, 36
availability, 20
choosing listings, 35
choosing text for numbering, 35
controlling page numbers, 35–36
creating, 33–39
creating style for, 38–39
explained, 20
flowing text, 38
getting bookmarks from, 40–41
including book documents, 38
including non-printing text, 38
limitations, 20
More Options button, 35
numbered paragraphs, 38
paragraph styles, 35
paragraphs, 34
PDF bookmarks, 38
replacing, 38
setting to run as paragraph, 38
styling listings, 35
Title listing, 34

TOC entries, sorting, 37
TOC levels, setting, 36–37
TOC options, setting, 37–38
transitions, previewing on page, 249

U
URL, choosing as Link To option, 23

V
video files

availability, 20
explained, 20
limitations, 20

video formats, 45–46

video overlays, using with tablet apps, 144–146
videos

adding to documents, 48
setting controller for, 49–50
streaming to documents, 50
using Media panel with, 48

W
Web Content overlays, using with tablet 

apps, 149–151
Wired magazine, 6
workflows

InDesign as “hub”, 9
InDesign features, 10–11

X
Xoom aspect ratio, 94
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